Getting Your Points Across: Effective, Efficient, and Entertaining Critiques of Student Papers

Jan M. Levine
Duquesne University School of Law
March 16, 2013

Using Inserted Comments in MS Word 2011 for Mac

- There is a very critical setting for the comment balloons to prevent crashes of the application and loss of your work.
- This is a work-around for an as-yet uncorrected bug in MS Word, and is very hard to find online (you won’t find the solution to the problem on Microsoft’s website or by contacting them).
Using Inserted Comments in MS Word 2011 for Mac

- Very long comments open up in the Sidebar because they're too large to fit into the regular Comment balloon, and the default font size for the Sidebar is very small.
- Most people don’t know how to change this, but the View/Zoom setting for the Sidebar can be set independently of the regular document and comment View/Zoom settings, so you can make the size of the Sidebar font match the size of the Comment font.
Customizing MS Word

Before you start customizing MS Word, or make any additional changes to MS Word in the future, always make sure you can restore the application to the state it was in before you began making changes.

While you can always start over fresh, you want to know how you can restore customizations you’ve already made without wiping everything out and reverting to a pristine original installation of the application.

First, we’ll be modifying a key file, titled “Template.dotm” to customize MS Word.

Word 2011 for Mac and Word for Windows (since 2007) both use the same kind of Template file, so files and Templates made for one operating system work just fine on the other, in the same way that .doc and .docx files can be opened and edited across platforms.

But Word 2011 for Mac is far more customizable than the Windows version of Word has been since the introduction of the Ribbon.

What’s a Template?

It’s a master file that contains your document Styles and other settings to format a new document.

It contains your Toolbars and Menus.

It contains your custom Word Macros written in the Visual Basic programming language.

And it contains your AutoText entries.

But in OS X Lion and OS X Mountain Lion (and also in Windows installations of MS Word) the file is hidden from your view, along with other system files, in the user’s Library folder.
With either the desktop or a Finder window as the front most application, hold down the option key and select the Go menu.

The Library folder will be listed as one of the items in the Go menu.

Select Library, and a Finder window will open showing the contents of the Library folder.

If you close the Library folder’s Finder window, the folder will once again be hidden from view.

From the Library folder, go to:
/Users/[USERNAME]/Library/Application Support/Microsoft/Office/User Templates
Open that Finder window, and you'll see a file named "Normal.dotm" in the folder.

Apple hides the Library folder in OS X Mountain Lion by setting a file system flag associated with the folder. Any folder on your Mac can have its visibility flag turned on or off; Apple just chose to set the Library folder's visibility flag to the off state. To reset the visibility flag, do the following:

Launch Terminal, located at /Applications/Utilities.

Make the Hidden Library Folder Visible Permanently

Apple hides the Library folder in OS X Mountain Lion by setting a file system flag associated with the folder. Any folder on your Mac can have its visibility flag turned on or off; Apple just chose to set the Library folder's visibility flag to the off state. To reset the visibility flag, do the following:

Launch Terminal, located at /Applications/Utilities.
Enter the following command at the Terminal prompt:
```
chflags nohidden ~/Library
```
You can copy that text and paste it at the location of the cursor, or just type the text. Then press the Enter/Return key.

Once the command is executed, you can quit Terminal from the Menu.
The Library folder will now be visible in the Finder.
Should you ever wish to set the Library folder back to its default hidden state, simply launch Terminal and issue the following Terminal command:
```
chflags hidden ~/Library
```

Now open a Finder window and go to:
```
/Users/{USERNAME}/Library/Application Support/Microsoft/Office/User Templates
```
Open that folder and you’ll see a file named “Normal.dotm” in the folder.

Option-­‐‑Click and drag the file to another location such as the Desktop, or even within the same folder, then release, making a copy.

Or right-­‐‑click and choose Duplicate from the choices that appear in the on-­‐‑screen menu.

This is added insurance, beyond what you have from Apple's automated Time Machine backup application or any other backup system you use.

Make a backup copy of your Normal.dotm Template file

If you ever delete the Normal.dotm Template file, an original unmodified Template will be recreated by MS Word when you restart Word, but it will be missing any of your customizations.

But you can restore the customizations you made to your Template by renaming the backup copy Normal.dotm and replacing whatever Normal.dotm file is in the folder.
I keep copies of my Templates, Toolbars, and AutoCorrect entries in the Microsoft User folder within the Documents folder.

I put a shortcut to the hidden Templates folder within the Backups of Templates folder.

And I put a shortcut to the Backup Templates folder within that hidden User Templates folder.
You can customize the default Template yourself, or you can copy another person’s customizations

- I’ll explain how to do both. But first, I will show you how to copy my custom critiquing Toolbars and Macros.
- Word 2011 for Mac makes this easy, with a tool called the “Word Organizer.” Word for Windows does NOT have this tool.

You can adapt my custom toolbars, buttons, & macros

- I copied my Template for your use.
- The file is titled “Jan Levine’s Template.dotm” and it’s on the flash drive distributed in the session, along with other materials.

- You may download it from the CloudApp URL at http://cl.ly/0g3C3G162X25
- Or you may download it from this Conference’s webpage, at http://www.duq.edu/academics/schools/law/academic-programs/legal-research-and-writing-program/legal-writing-conference-2013
• Copy that file to your own non-default custom Template folder, which is found in a different location than the default Template, at:
  /Users/[USERNAME]/Library/Application Support/Microsoft/Office/User Templates/My Templates
• You can always copy things from my Template in the future if you want to make changes to your own Template.

• We want to open “Jan Levine’s Template.dotm” so you can copy the Toolbars and Macros.
• You could just double-click on the Template file from your desktop, or browse to it in Word using the Open menu command, which will instantly open the Template.
• But knowing how to store and open Templates is a good idea anyway, so let’s do it that way.
You may see a warning window appear. If so, just click on the button Enable Macros.
Now you will see the Critiquing Toolbar appear. Now you can copy my custom Toolbars and all of my custom Macros to your own default Template.

Word 2011 for Mac makes this incredibly easy, with a tool called the "Word Organizer" available from the Format Menu and the Style command. Word for Windows does NOT have this tool, so those users have to create Macros individually.
First we’ll copy all of the custom Macros, which are in the Macro Project Item entry, over to your Normal.dotm Template.
Then we’ll copy the three custom Toolbars.
Each of those includes simple custom Toolbar buttons I “drew and painted” using simple image editing applications to match the Microsoft colors used for the standard highlighting and text colors.
But today’s session won’t explain how to create the simple images for Toolbar buttons.
Close the Organizer tool and then close MS Word.
You may get a prompt asking if you want to save the changes made to your Template; if so, click “yes” to accept the changes.
Then re-open MS Word.

Next, go to the View menu to select one or more of the new Toolbars.
Next, go to the Tools menu, click on Macros, and you should see all of the new Macros ready to run, to be edited, or be deleted.

The Custom Macros can now be run from the Tools Menu, by clicking on Macro and opening the list of Macros.

Critiquing Macro #1
- Extracting Comments to another document.
- Here's a typical document with many comments.
Here is the result of running the Macro: a separate document with a chart showing easy-to-read comments linked to the relevant in-document text.

Critiquing Macro #2

Extracting TrackChanges to another document.
Here's a one-sentence document with the Tracked Change showing colored red and underscored.

This is the result of running the Macro: a separate document with the changes shown in an easy-to-read format.
More Custom Macros

- Save and copy an open file to two locations at once (such as your hard drive and a backup on a USB flash drive or another external drive).
- A set for Highlighting – all available standard Microsoft Office colors.
- A set for Coloring Text – all available standard Microsoft Office colors.

More Custom Macros

- Change from automatic numbers to normal numbers when copying a numbered list to a new document.
- Print numbered copies of a document.
- Extract all the AutoCorrect entries into a document.

Windows vs. Mac OS X

- The Mac’s Unix-based file & folder syntax uses colons instead of slashes.
- So when you use a Visual Basic macro written for Windows on a Mac, and a file location is specified, you have to change a location such as “C:\Documents\Book\Chapters\” to the Mac equivalent “HardDrive:Users:MACOSUserName:Documents:Book:Chapters:”
- Anyway, you will have to edit the Macro to save a duplicate copy to match the name of your own USB flash drive or other external drive.
Sources for Macros

- There are many websites and usergroups that share custom Macros.
- There is a list of sources at the end of the presentation.
- The source for most of the Macros I’ve given you is DocTools.com

Toolbars

- In my Template I have modified the standard Word default Toolbars and Menus, created three custom Toolbars, and added corresponding Menu entries for some of the Macros.
Toolbars can be created, deleted, edited, resized, or docked.
You can create a Toolbar button to run a Macro directly from your Standard Toolbar, or from any Toolbar you choose (even a new one you create).
You can also create a custom Menu entry to run a Macro by dragging a Macro to a location in the Menu bar.

Macros have a standard name format and a standard button image, but you can change the name by double-clicking on the dragged Command and then clicking within the resulting Properties field for the name.

You can change the button image from a small number of Microsoft-supplied buttons (until you learn how to create your own custom button images).
AutoCorrect

- This is the tool you can use to have Word automatically "replace" words or keystroke combinations "with" expanded and formatted text.
- This works just like spelling corrections you or Microsoft set to happen automatically, or like a "search and replace" from the QuickSearch bar.
- In a document, type and format the character string you want to be stored as an AutoCorrect entry, then open Preferences from Word’s Menu, and type in the characters you want to trigger the replacement.

AutoCorrect Entry Page: 

Open Word Preferences from the Menu, and select AutoCorrect. 

Personal Settings:
- User Information
- About Word
- Feedback
- File Locations
- Ribbon

Other Content:
ClipMenu

- This is a free OS X clipboard expander works across all OS X applications that use copy/paste.
- You can copy and paste images or text.
- You can work with plain text or styled text, edit snippets, and manipulate text case and styling while pasting.
- You can create individual Snippets and Snippet Collections for critiquing different assignments.
- And you can create Snippets for other uses.
Works across all OS X applications.
You can trigger the pasting of typing of blocks of
plain text or formatted or pasting of images
by typing short strings of characters on the
keyboard, or by selecting the action using two
mouse clicks on an item from a drop-down list
out of the Menu Bar.
You can create Clipping sets, any one of which
can be open at a time.
This $20 application lets you easily record audio comments on student papers, using your laptop’s built-in microphone or an external higher-quality microphone.

The application is built around the way we used to use a cassette recorder.

You can E-mail the audio comments directly to your students from within the TapeDeck application, using your default e-mail application.

You can color-code and organize the resulting audio comment files.
Websites about MS Word

Websites about MS Word
- http://www.microsoft.com/mac
- http://www.microsoft.com/mac/support
- http://www.msofficeforums.com/
- http://www.officeformachelp.com/
- http://www.thedoctools.com/

Websites about Mac Apps
- http://mac.appstorm.net/
- http://mac.tutsplus.com/
- http://osxdaily.com/
- http://reviews.cnet.com/macfixit/
- http://www.addictivetips.com/category/mac-os/
- http://www.cultofmac.com/
- http://www.maclife.com/
- http://www.macrumors.com/
- http://www.macupdate.com/
- http://www.macworld.com/
Questions?